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Set Up for a University of Michigan Mailbox…  
 
If it is the first time you have opened Outlook, the setup wizard will prompt 
you to set up your mail.  Follow the wizard prompts.  Choose Internet mail.  
Your address is your uniqname@umich.edu; your account is your uniqname. 
Enter your incoming mail server as *.imap.itd.umich.edu where * is the first 
letter of your uniqname.  Enter the outgoing server name as 
smpt.itd.umich.edu.   
 
If you have used your copy of Outlook before, go to the Tools menu and 
choose Accounts.  Click on the Add button.  Enter the information above. 
 
Connect to the Internet then click on the Send\Receive button when you want 
to check for new messages or send messages in your Outbox. 
 
Before You Retrieve Your Messages for the First Time:  Outlook by default 
will remove the messages from the server when you receive them.  This will 
no longer allow you to view these messages from Mulberry in the lab or 
using the http://mail.umich.edu web mail service.  We recommend changing 
this default to leave the messages on the server.  Go to Tools – Accounts – 
Mail Tab.  Select your account and click on the Properties button.  On the 
Advanced tab, check mark the Leave a Copy of Messages on Server box.  You 
may also wish check and enter a reasonable amount of time after which to 
remove them from the server, or remember to delete them using Mulberry or 
web access, or your mailbox will fill. 
  
For additional assistance, please see a lab assistant. 
 

mailto:uniqname@umich.edu


 
 

Adding the UMBS Database Download Application 
 
The Outlook Download program allows Outlook2000 to recognize data 
packages with the extension .UMBS.   This data includes contact information, 
event information, and interview schedule information from the Business 
School database. This module offers a useful way to import contact/event 
information into Outlook2000.  It then can be synchronized from Outlook to a 
Palm Pilot or other PDA.  
 
To install this application, you first must have Outlook 2000 installed.  The 
application will not work with other versions.  Installation and set up of the 
UMBS Outlook Download application has three steps: download the 
installation file, install the software, and configure the software.  The link 
below will take you to a series of web pages with instructions for each step. 
Note you will need to close all other applications and reboot. 
 
Download it from the Computing Services Software page in M-Track at: 
http://mtrack.bus.umich.edu/ComputingServices/Software/OutlookDownload/
default.htm 
 
This process will add a “UMBS Download” button to Outlook’s toolbar.  
You simply click the button every time you wish to download contacts from 
the UMBS Database. 

http://mtrack.bus.umich.edu/ComputingServices/Software/OutlookDownload/default.htm
http://mtrack.bus.umich.edu/ComputingServices/Software/OutlookDownload/default.htm


 
 

 
Introducing Outlook2000 - Your Personal Information Manager…  
 
Microsoft Outlook coordinates your e-mail, calendar, contacts, and tasks.  It 
allows you to write yourself notes, track your activities in a journal, manage 
your files, and even browse the web and save shortcuts to your frequently 
visited pages. 

 
 
Watch Out for the Expanding Menus…  
 
! Please Note:  Office 2000 uses a smart menu scheme that only displays the 

most recently used commands, so many commands on the menu may not be 
displayed.  If you can't find a command you think should be under a certain 
menu, look to see if there is a double arrow at the bottom of the toolbar - 
double click on this arrow to expand the menu.  The next time you use the 
menu, the command should be visible and higher up on the menu. 

 
Opening Outlook  
 
Double click on the Outlook Icon from your desktop or select it from your 
Start - Programs menu.   
 



 
 

The Outlook Window: 
 
Outlook has a convenient "Outlook Bar" with shortcuts to the various 
Outlook functions, and a convenient "Folder List" (similar to the Windows 
Explorer) that are visible in any mode.  Turn the Outlook Bar and Folder List 
off and on using the View menu.   
 
Use the Outlook bar on the left to switch between the different modes. 
Navigate to different folders using the Folder List. Note that you receive the 
same result by clicking on the Inbox icon on the Outlook bar or by clicking 
on the Inbox Folder in the Folder List - the Outlook bar icons are merely 
shortcuts to these folders.  Information is displayed in the center area. 
 
Outlook typically opens in the Inbox mode.  You can also set the Outlook 
Today mode to open first for a quick synopsis of your daily calendar, new 
messages, and task list. (Go to the Outlook Today icon, and choose 
Customize Outlook Today in the top right corner to set this up.) 
 
Following is the Outlook window displaying the Inbox: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Outlook Bar

Folder List 
(Inbox, Drafts, Sent 
Items,  Personal 
Folders, etc.) 

Sizing Ba

Status Bar 

s 

Worth Noting:
Menu options 
and toolbar 
functions are 
"smart" - they 
relate to the 
current module 
you are in.   
 
For example, if 
you are in the 
Inbox, the New 
button on the 
toolbar will 
automatically 
begin a new 
message, but if 
you are in 
Contacts, then 
that same 
button will 
create a new 
contact. 
Menu and Tool Bar
Message List in Table View
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Reading E-Mail Messages in Outlook 
 
 

 

 
If you do not wish to keep the message, click the Delete button on the 
toolbar in the open message window, or select the message in the Inbox 
table and press Delete.   
 
What Happens to Your Deleted Items?   Similar to the Recycle Bin, deleted 
messages are moved to the "Deleted Items" folder and not truly removed 
from the server until you empty this folder.  To empty the folder, right click 
on the "Deleted Items" icon in the Outlook bar and choose "Empty Deleted 

Single click on a message and it 
will automatically display in 
the preview pane in the bottom 
half of the window. 
 
The width between the window 
panes can be adjusted by 
dragging your mouse on the 
border between them. 
 
Use the buttons on the 
Standard Toolbar to reply to 
the active message. 
 

Double click on a message 
and it will open in a 
separate window. 
 
Use the buttons on the 
toolbar in that window to 
reply or forward the active 
message. 

Tip:  use 
the space 
bar to scroll 
through 
your 
messages 
along with  
the delete 
key to 
quickly and 
easily 
manage 
your inbox.  



 
 

Items Folder."    You can also automatically empty it every time you close 
Outlook - set this on the Tools - Options - Other tab. 
 
Read and UnRead Messages:  Outlook marks messages as “Read” or 
“Unread.”  Unread messages appear in bold, while read messages are 
dimmed.  In typical setup, viewing a message in the preview pane marks it as  
“read.” 
 
Filtering Your Messages:  On the Advanced Toolbar, there is a button to 

filter your inbox in many different ways.  It is recommended you turn this 
Toolbar on - go to View - Toolbars - Advanced Toolbar (don't worry - there 
is nothing really "advanced" or hard about it!). 

 
 
 
 
Moving Messages Into Folders: 
 
Turn on the Folder List from the View menu if it is not visible.  Scroll, expand 
or collapse the folder structure as necessary so that your desired folder is 
visible.  Drag the message from your inbox to the folder.   
 
To move a file from one folder to another, select the folder so that the file 
appears in the list, and drag it to the new destination. 
 
To create a new folder, select the location where you want it in the Folder 
List, then choose File - New Folder, or right click in a blank area of the 
folder list and choose New - Folder.   Enter the Folder name.   
 
!Note your Sent mail folder.  
 
!Note your Drafts folder.  This will be used for Drafts you create in 

Outlook.  If you begin a message, and use the X box to close the window 
that the message is in, Outlook will prompt you to save it as a draft in this 
folder. 

 



 
 

Sending E-Mail Messages in Outlook 

 
Go to the Inbox and click on the New button on the toolbar, choose File - 
New - Message, or press Crtl+N. 
 
In the To:… field, type in a complete Internet address (janedoe@aol.com, etc.). 
Separate multiple recipients with semi-colons (;). 
 

! Create Your Own Distribution Lists:  In Outlook it is easy to create your 
own private group mailing lists.  After Clicking the To button to address a 
message, click on the New button, choose New Distribution List then click on 
the OK button.  

 
Enter a name for the list, then click on the 
Select Members button to choose names 

from the Global 
Address List and your 
Contacts, or click the 
Add New button to add 
a complete e-mail 
address that is not in 
either the Global 
Address List or a 
contact.   
 

 
Once you have created a list, it is stored as a Contact by its name.  You can 
later add and remove names by opening it in Outlook’s Contact mode (see 
the next section).  When addressing a message, you can use this group list by 
selecting it just as you would any other contact. 

mailto:susie@aol.com


 
 

Adding and Viewing Contacts 
 
To store e-mail addresses, you will want to create "contacts."  Click on 
Contacts on the Outlook bar and press Ctrl + N, or choose the New button on 
the Standard Toolbar, or choose File - New - Contact.  Fill in the form with 
the e-mail address and contact information.   
 

 
 
 
 

 
These contacts can be easily viewed at a glance.  Double click on any contact 
to view or add more information.  Choose File Print for different options to 
print them out in various styles, such as a phone list, as cards, as a booklet, 
etc. 
 
To automatically add an e-mail address from a message, you can drag a 
message from the Inbox into contacts to create a new contact, or right click 
on the From field in a message with an internet address to create a new 
contact, but you may need to clean up the record a little.  
 
You can also drag a contact onto your Inbox icon to begin a new message 
automatically addressed to that person. 

Note the 
alphabetical 
tabs to quickly 
jump through 
your contacts as 
your list grows. 



 
 

While in Contacts, you can create new folders and drag your contact records 
into these folders for organization.   
 
Use a Palm Pilot?  Please note if you plan to sync with a Palm Pilot, your 
Palm address book entries will be added as Contacts, but Outlook's Contact 
sub-folders will not sync with your Palm Pilot.   
 



 
 

Using Outlook's Calendar 

• Click on a time slot, or dra
create an “Appointment.”  
details. 

• To easily enter recurring a
on the Recurrence button, t
need to modify a meeting th
the change to all occurrenc

• To set a reminder "alarm"
reminder box. 

• To delete a calendar entry,
• To change calendar views,

monthly calendar in the upp
• To Print A Copy Of Your C

Under Print Style, choose t
not a lot of customization fo

Task List 

Month 
View 
Open appointment window -double 
click on an appointment to open it for an 
area to type details, set a reminder alarm 
checkbox, a recurrence option, the ability 
to invite others to make it a meeting, and 
more.
g to select a block of time, and type in text to 
Double click on the entry to open it and set 

ppointments, open the appointment and click 
hen choose the desired options. If you later 
at reoccurs, it will ask you if you wish to apply 
es, or only the one being modified. 
 open the appointment and checkmark the 

 select it and press Ctrl + D, or choose Edit - Delete. 
 use the View menu or click on the small 
er left corner. 
alendar, in Calendar mode, go to File - Print.  

he desired layout.  Sorry - at this point in time, 
r calendar layout is possible. 



 
 

Getting Help: 
 
• Remember Outlook’s On-Line Help. 
 
• Check Microsoft’s web site at www.microsoft.com/office/outlook 
 
• Remember there are many good books available.  
 
• For additional instruction, please use the NetG Outlook tutorial available 

from ITCS’s education website at www.itd.umich.edu/education.   

http://www.microsoft.com/office/outlook
http://www.itd.umich.edu/education

